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Preface

Computer

: Computers, a series of eight books, is a carefully arranged Computer series,

that perfectly complies with the NCERT syllabus criteria and the National
Curriculum Framework's vision. In auordance with NEP 2020’s guidelines,
the series adopts an interactive approach to make Learning about
Computer enjoyable for students. This book includes enough questions in
accordance with the NEP criteria. The fundamental principles of NEP which
are recognising, identifying and fostering the unique capabilities of each
student, respect for diversity, and respect for the local context in all topics,
are always kept in mind while creating the book.

The topics are introduced in a way that children experience and learn
through exploration.

Child-friendly language and contextual images have been incorporated
throughout the series to make the material more understandable for young
readers. This allows them to connect what they read and relate it to the
views, ideas and experiences they encounter every day.

Salient Features of the series:

Learning Outcomes

Warm Up
Teacher’s note
Let me answer

Do You know
Remember It

Kids’ IQ

Up skill your
Intelligence
Critical Thinking

Team Work

It shows the right path of learning to the teachers as well as students. It
establishes the direction of learning for efficient and superior learning
results.

: Children can connect their prior knowledge to the chapter's topic through

simple yet engaging activities.

: An outline of guidelines for teachers to follow in the classroom in order to

make lessons interactive and discussion-based.

: Quastiens related to the topic which are essential for checking pupil

understanding and keeping them engaged with the task at hand.

: An interesting piece of information related to the topic.

: Additional information about the topic to encourage children to wonder

about various surroundings.

: These questions have been included to reinforce learners to think, analyse

and apply.

: Ample exercises with a range of questions to support learning.

: Questions which allow the learners to think clearly and rationally. Further,

permit the learners to understand the logical connections between ideas in
order to analyse facts and come to a conclusion.

It enables the students to collaborate with others.

The content is structured and well-graded. Sincere efforts have been taken to prevent any
inconsistencies and make this series a perfect complement to the students' education. Any worthwhile
recommendations for how to improve the series are always welcome and greatly appreciated.

Author
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EVOLUTION OF COMPUTERS

Q Learning Outcomes
At the end of this chapter, students will be able to:

+ Know about varieties of calculating devices.
+ Comprehend the differences between various calculating devices.

+ Explain the evolution of computers.

Look at the pictures carefully and circle the pictures which are able to
calculate.

M\ Apprise students that earlier computers were only designed to function like calculating
devices.
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I“\f‘ . “Hey Friends! We have already
(o b covered the components of computers
in the previous class. Now, let’s learn
about the changes that computers
have undergone over time.”

Over the past few decades, computers have undergone significant
advances. Many years ago, in their most basic form, computers were
very huge and slow. Computers have evolved over time to become faster
and smaller. Earlier, Abacus helped people to do calculations and now
computers are envisioned to perform this task.

Calculating devices have been developing ever since, giving rise to the
potent computers we have today:.

& ssacus

The abacus is considered to have been the BN -
. . &% Do You Know?
earliest mechanical calculator. It was used : ‘
. . . Abacus is also called a counting frame.

to rapidly and easily conduct addition

and subtraction.

?

An Abacus is made up of a wooden
frame with rods, each having
beads. It is divided into two parts
called ‘Heaven’ - the upper part and
‘Earth’ - the lower part. By carefully
positioning the beads, any number
can be displayed.

Have you ever done calculation
using an abacus?
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& NariER'S BONES

John Napier of Scotland invented Napier’s
bones in 1617, a manually driven calculator for
calculating products and quotients of numbers.
It made the method of multiplication simple
and also increased the speed of performing
multiplication. This reduced the risk of error in
large multiplication problems. This instrument
was more compact than the earlier creations.

Figure 1.2: Napier’s Bones

& AriTHMETIC MACHINE

Blaise Pascal created the mechanical calculator
known as Pascal’s calculator, often referred to as
the arithmetic machine or Pascaline, in 1642. It
represents the position of digits with the help of
gears in it. Figure 1.3: Pascaline

Pascal designed the machine to add and subtract two numbers directly
and to perform multiplication and division through repeated addition
or subtraction.

& s1EPPED RECKONER

German scientist, Gottfried Wilhelm Leibniz,
created the stepped reckoner, sometimes
referred to as the Leibniz calculator, in 1672
and finished it in 1694. The machine performs :
the basic operation to add and subtractaswell =~ Figure 1.4: Stepped Reckoner

as multiplication by repeated . A
. L REMEMBER IT! | & =
addition, and division by [ .-
ted subtracti Sir Charles Babbage is also known as the .
Iepeated subtraction. ‘Father of the Computer’ ¢
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& ANALYTICAL ENGINE

English mathematician and computer pioneer,
Charles Babbage, created a mechanical general-
purpose computer called the Analytical Engine. It
could perform any calculations. It had four different
components or parts. These components are the
reader, the store, the mill and the printer which are
essential components of every computer, even today.

B
F

Figure 1.5: Analytical Engine
@let Me Answer

Whatarethecomponents
of computer?

& 1ABULATING MACHINE

Tabulating Machine was invented by an
American Statistician Herman Hollerith. This
machine had the ability to read and process
the data, further giving the desired output.
Punch cards were used to give the inputs.

é ENIAC Figure 1.6: Tabulating Machine

Inventedby AmericanphysicistJohn Mauchly
and American engineer J. Presper Eckert in
1946, ENIAC was the first programmable,
electronic, general-purpose digital computer.
These features were available on other
computers, but the ENIAC offered them all F >
in one convenient package. It could solve a Figure 1.7: ENIAC
vast category of numerical problems through reprogramming.

Q UNIVAC I

UNIVAC I stands for Universal Automatic Computer . H
It was the first commercially available general-purpose
electronic digital computer designed in the United States
for business applications. Figure 1.8: UNIVAC-]
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é HARVARD MARKI

Howard Aiken at Harvard University and IBM
developed the Harvard Mark I in 1944. It is
also referred to as the Automatic Sequence
Controlled Calculator. Figure 1.9: Harvard Mark-I

It was a general-purpose electromechanical computer. It also provided
vital calculations for the U.S. Navy during World War II. One of the
early programs to run on the MARK I was initiated on 29th March 1944
by John Von Neumann.

. ,,,ﬁ\v KldS ’Q

Arrange the following devices in descending order according to their year of
invention.

. J

* Let’s Recall

The abacus is considered to have been the earliest mechanical calculator.

o Blaise Pascal created the mechanical calculator known as Pascal’s calculator.
« John Napier of Scotland invented Napier’s bones, a manually driven calculator.

o Charles Babbage created a mechanical general-purpose computer called the
Analytical Engine.

o UNIVAC I stands for Universal Automatic Computer I.
« ENIAC was invented by John Mauchly and J. Presper Eckert, in 1946.

o Howard Aiken at Harvard University and IBM developed the Harvard Mark I
in 1944.
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A. Fill in the blanks.
1. Abacus is divided into two parts called “ .................. > - the upper part
and “ ... > - the lower part.
2. Over the past few decades, computers have undergone significant
3. UNIVACIstands for .....................
4.  Charles Babbage created a mechanical general-purpose computer called
the ..o,
5. One of the early programs to run on the MARK I was initiated by
B. Answer the following questions.
1. State the features of the Abacus.
2. List any two differences between Arithematic Machine and Napier’s
Bones.
3. Who invented Stepped Reckoner?
4.  State any similarity between ENIAC and UNIVAC L.
X Copuerd | mm w X assmx X x= ¥ ¥ == X X NN




5.

State any two features of Harvard Mark I.

C. Match the following.

1.

o WD

1642 ENIAC

1617 Harvard Mark I
1694 Pascaline

1946 Napier’s Bones
1944 Stepped Reckoner

D. Write ‘T’ for True statements and ‘F’ for False statements.

1
2.
3.
+f
5

Abacus is also called a counting frame.

Analytical Engine had four different components.

aua

John Napier created the Stepped Reckoner.
Sir Charles Babbage is also known as the Father of the Computer. [ |
Punch cards were used to give the outputs in Tabulating Machine. [:]

E. Tick (V') the correct answers.

1.

The Mill, Store, Reader and Printer are components of the ...................

() a. Napier’s Bones () b. Arithmetic Machine

() c. Abacus () d. Analytical Engine
.................... is designed in the United States for business application.
() a. UNIVACI () b. Tabulating Machine

() c. MARKI () d. Pascaline

Tabulating Machine was invented by ....................

() a. Charles Babbage () b. Blaise Pascal

() c. Herman Hollerith () d. Leibniz

Which calculator represents the position of digits with the help of gears
in it?
() a. Pascaline [ ) b.Abacus [ ) c. ENIAC [ ) d.UNIVACI

B X X
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5.  One of the early programs to run on the MARK I was initiated on ............ .
Q a. 29th April 1943 () b.29th March 1944
c. 27 March 1944 () d.21 May 1956

@ Critical Thinking

A. Rahul is giving/writing his exam and he is stuck on the question which
asks, “Tell the name of the calculating device which was invented by a
German scientist in 1694.” Help him to find the answer.

B. Unjumble the following devices.

1. ANIEC m ettt et
2. ELAASCNPI m e st sae s
3. PNREIA EBSON - e,

Team Work

With the help of your Maths teacher, use the Abacus for doing mathe-
matical calculations. Discuss the benefits of using an Abacus. Further,
label the parts of the Abacus given below.

= Computer-4




ORGANISING FILES AND
FOLDERS

Learning Outcomes

At the end of this chapter, students will be able to:
+ Manage files and folders using Windows 10.

+ Create a folder.

+ Rename, delete and restore a file and folder.

Reena wants to organise the things in a proper way. Help her by matching
the objects with their appropriate storage.

Q
® 'I'Je,acher’s Inform students that we keep or arrange our items at home. Similar to this, we can use
2\ Note: files and folders to keep our data on computers.

EYX X =<
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“Hi Friends! Lets learn how to
keep our data in files and folders
on computers.

We make files and folders which makes it easier for us to remember
where we have stored our work. Let us learn how to manage files and
folders using Windows 10.

& ATTRIBUTES OF WINDOWS 10

+ In Windows 10, multiple users can work on one computer system at
the same time.

< The search tool of Windows 10 is called Cortana which lets us search
for any information on the system or on the internet directly.

« It also provides the feature of downloading free and paid apps from
an application called the Microsoft Store.

+ We can open numerous desktops simultaneously
by using the task view button.

< 'The snap feature allows us to drag and drop a Windows 1
window to a corner of the screen, thereby making Figure 2.1:
space for the other application. Windows Logo

< It enables to start more than one program at a time.

@ let Me Answer

Which is the most commonly
used operating system developed

%y Do You Know?
Cortana interacts naturally via talking or typing and

provides relevant recommendations, quick access to
: : 2 . . ) )
by Microsoft Corporation: information, better searches and important reminders.
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é FILES

A file is a collection of data or information. When you save your work in
a program, it is saved as a file. Files are

represented on computers by icons. The @.‘_ —

Windows 10 operating system allows

us to generate many file types. The type WordFile ~ PowerPoint Picture
of file can be recognised by its icon. e Flle

& rorpers

A folder serves as storage for files .

or other folders. A folder within a i ﬁ

folder is called a sub-folder. We can = —

create any number of folders where  Pictures Desktop Documents
Folder Folder Folder

each can hold any number of files

and subfolders.

& CrEATING A FOLDER

Follow the given steps to create a folder.
Steps:

+ Go to the location where you want to create the

folder.
< Right-click on a blank space.

<% Select New then Folder from the contextual

Figure 2.2:
menu. Creating a Folder

+ Windows will create the new folder at your current location.

< Enter your desired folder name and press enter.

Shortcut Keys Combination: Press Ctrl + Shift + N key combination to create a new folder.

K X
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& 1L EXPLORER WINDOW

File Explorer window ipaag

provides comprehensive =

details of the drives, files, N | . N J\
and folders that are present

in our system. In this : &

window, we can also create,

open, move, or remove a

folder.

Figure 2.3: File Explorer Window

é OPENING FILE EXPLORER

Follow the given steps to
open File Explorer.

Steps:

1. Click on the Start button.
2. Select the File Explorer.
3. TheFile Explorer window

will open. Figure 2.4: Opening File Explorer

Shortcut Keys Combination: Press Win + E key combination to open Window File Explorer.

é OPENING A FILE AND FOLDER
Follow the given steps to open a file and a folder.
Steps:

1. Click on the Start button.

2. Open the file explorer window.

3. Choose the folder or a file you want to open.

X Computerd | S X X iy
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& contexT MENU

A context menu (also called a contextual, shortcut and pop-up or pop-up
menu) is opened when we right-click anywhere on the app. It provides
options that can be accessed quickly. Let us know how to use the context
menu.

& usiNG cONTEXT MENU

By using the context menu, a folder can be opened. | v >

Sort by

Follow the given steps to open a folder using the
context menu.

Refresh

SthS: Undo Rename Ciri+2
1. Choose the folder you want to open. N >
Right-click on it.

0 = Display setiings
3. From the context menu, select the open option.  Figure 2.5: Context Menu
4

& Personalize

The desired folder will open.

é RENAMING A FILE AND FOLDER

Have you ever given a
name to someone and
wanted to change the A
name later? Similarly, . - -

sometimes you may want . ‘_ E = )‘ i
to change the name of T

an existing folder or file. = G i _ . z
In doing so, renaming is = = |
required. Renaming is to '
change the existing name Figure 2.6: Renaming a File
of the file or folder.
ERY X === ==x X S X X === _ Compuerdi =X 3B
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Follow the given steps to rename an existing file or folder.

Steps:

1. Right-click on the folder or file & Lt Me Answer

that tt What would you do if you save a Science
at you want to rename. project by the name of a Maths project?

2. Click onthe Rename option from
the context menu.

3. Type the new name for the folder or file. Shortcut Keys: Press F2

4. Press enter. to rename a folder.

é DELETING A FILE AND FOLDER

There are some unused = -

files and folders which

you may want to delete. " | H:& i §
Deleted files or folders .77~ i

will be sent to the Recycle —

Bin. kit
Follow the given steps to ‘_H i 2
delete an existing file or = m#r
folder. - e e
Steps: = e
1. Right-click on the .l e -
folder or file which s —
you desire to delete. ~ *" Q- E f . !
2. Click on the delete

option from the
context menu.

Figure 2.7: Deleting a File or Folder

Shortcut Keys Combination: Press the Shift + Del key combination.

Computer-4
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é RESTORING A FILE AND FOLDER

Sometimes you might ==
unintentionally delete a file.
To bring back the file from the
recycle bin is called restoring.

Follow the given steps to restore -~ === —

any file or folder. ,

Steps:

1. Double-click on the Recycle ' TS ST nagme e
bin icon on the desktop. ;

2. 'The contents of the Recycle
bin get displayed in a new — —
window. Figure 2.8: Restore

3. Right-click on the file or the folder you want to restore.
Click on the restore option from the context menu.

5. The file or folder will be restored to its original location.

& ..,@\v K!ds ’Q

I am the pop-up menu you see when you right-click the mouse. Who am I?

@ Let’s Recall

In Windows 10, multiple users can work on one computer system at the same

time.

A file is a collection of data or information.

A folder serves as storage for files or other folders.

A folder within a folder is called a Sub-folder.

A context menu provides options that can be accessed quickly.

Renaming is to change the existing name of the file or folder.

I
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A. Fill in the blanks.
1. The Search tool of Windows 10iscalled .....................

2. Wecanopen numerous desktops simultaneouslybyusingthe....................
button.

3. 'The type of file can be recognised by its .....................
4. A folder servesas ........cc....... for files or other folders.

5. A context menuisalsocalleda................... menu.

B. Match the following.

1.  Ctrl + Shift + N key Rename a folder

2. Win + E key Create a folder

3. F2 Delete a folder

4. Shift + Del key Open File Explorer

C. Write ‘T’ for True statements and ‘F’ for False statements.

1. Search Tool is an application where you can get free and paid apps. D

2. Afolder is a collection of data or information. ()
3. Restoring is changing the existing name of the file or folder. ()
4.  After restoring, the file will move to its original location. ()
5. By using the context menu, a folder can be opened. ()

D. Tick (v) the correct answers.

1. Deleted files or folders will be sent to .....................
() a. Search Tool () b. Window Store
() c. Recycle Bin () d. Window Explorer

X Computerd | S X X e X
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A folder within a folder is called a ...................

() a. In-folder () b. Inside-folder

() c. View-folder () d. Sub-folder

It shows a series of commands to access quickly.

() a. Title Bar () b. Context Menu

() c. Tab Menu () d. View Menu

If you want to give a new name to a file or folder, you will .................... it.

() a. Restore [ | b. Delete () c.Rename [ | d.Move

Which button provides the ability to open multiple desktops at the same
time?

() a. Rightclick () b. Task View () c. Ctrl () d. Shift

. Answer the following questions.

State any three features of Windows 10.




= Computer-4 r #

@ Rl L ‘

Rahul wants to create a folder. The steps he has written are not in order.
Number the steps to help him create a folder.

« Windows will create the new folder at your current location.
« Enter your desired folder name and press enter.

o Select New then Folder from the contextual menu.

« Go to the location where you want to create the folder.

 Right-click on a blank space.

Lo00d

Team Work

Circle the files in red colour and the folders in yellow. Further, discuss the
steps of deleting a file with your partner.
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MORE ON PAINT 3D

Q Learning Outcomes

At the end of this chapter, students will be able to:
+ Transform a 2D drawing into a 3D model.
+ Add texture and stickers in Paint 3D.

| PR - I g e

' zjal:hel"s Apprise the students to recall what they learnt in class 3 about Paint 3D and assist them
2\ Note: [ identifying the components of the Paint-3D window.

ERY X =< = r X X meflmes = X s | Computrd X N
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“Hi friends! Let us learn
how to add stickers and
texture in Paint 3D.

Windows 10 provides a free built-in creative app called Paint 3D. It
is a fantastic programme that enables us to create either creative or

professional projects. Both 2D and 3D tools are available.

Let us recapitulate what we learned in the previous class about the

Paint 3D app.
The Paint 3D window has the following options.

When you click on the expanded menu button, it opens a
variety of list options such as New, save, save as and many more to

perform multiple functions.

Brushes tool has different brush types, which are used
to draw lines by hand in various styles. It can be used to paint on
both 2D and 3D surfaces.

S B This option is used to draw 2D shapes. This tool has

many readymade shapes such as Lines, Rectangle, Stars, Arrows,

Triangles and many more.

2RI DAY This option allows to draw 3D shapes, such as cube,

cuboid, cat, woman, and many other 3D shapes.
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q"" i r"!" W frike g
e raa
Boooa .
oolen b .'G & A b
L R ®
e Discuss the difference between | 80
i 2D and 3D shapes. TeL D
Figure 3.1: 2D Shapes Figure 3.2: 3D Shapes
SN 9IS With this tool, we can sk
select images from a ready-made . = = T
image collection and apply them as ™
- ?" -
stickers to our designs. The opacity .
& ° -
of the chosen and applied sticker S 5 I U

can also be changed. = s o e
FETSETON This tool allows toadd  © @ © ©

Figure 3.3: Stickers ~ Figure 3.4: Text Tool
2D text or 3D text options in the drawings.

7 IR B et It is a collection of thousands of free 3D models

divided into several categories.

L) 6.

&= 30 My

- - . . T : Y ILEN
3 D e J iRAnm

B A ) & -
. — !
R ] LT ¥ Bk b
JE. il - B
ilfé ' l i I g -ﬂ
K Ot ] '-.n.-: T T . u — ==
Figure 3.5: 3D Library Figure 3.6: Canvas
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The canvas of the 3D é,? Do You Know?

Paint window is the area where By holding down the page up key, you can zoom

in on the canvas.

we can draw different drawings.

& 3p LiBrARY

Creative 3D objects can be created using Paint 3D. The app allows using
a variety of pre-defined objects in the 3D library. There are many 3D
objects freely available in the 3D library built by professionals.

Follow the given steps to insert 3D models from the Paint 3D library.
Steps:

1. Start Paint 3D from Apps.

2. Select 3D shapes from the ribbon and then Open the 3D library.

A~ e Ipv— [ § = . ey

Figure 3.7: Paint 3D App Window Ribbon

3. Type the object name into the search box and press enter.

f il

i; *:_-. D 5 - o

{ E!- . ¥ .

Figure 3.8: 3D Library Search Box Figure 3.9: Adding 3D Model to Canvas
4. Click on the model of your choice to add it to the canvas.

@ Let Me Answer

é 3D DOODLES What does Doodle really mean?

A freehand sketch can be transformed quickly into a 3D object using
Paint 3D. 3D doodles look very attractive.

{
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Follow the given steps to create a 3D doodle in Paint 3D:
Steps:

1. Launch Paint 3D.

Figure 3.10: Paint 3D
2. Select 3D shapes from the ribbon.

3. Select any of the 3D _
doodles.

4. Just drag it on the | 5 |3
screen and draw the 3D :

doodle on the canvas.

5. You may rotate, resize,
and edit the colour of
your 3D doodle after Figure 3.11: 3D Doodle
you've finished drawing it.

é 3D VIEWS T o ——

b - ]

3D view enables you
to edit from any angle, s =
which means even more

accurate and intuitive ) \"; _ Wiy dals
3D creation. You can iR -
move around your 3D I"!--' |
designs. ©
Figure 3.12: 3D View
ERX X === = ==X X Eaffjasx X X mmx _ Compuer4 3 3




é APPLYING STICKERS AND TEXTURES

Follow the given steps to apply stickers and textures.

SR T T L, s vou
Steps: = = _
1. Select the 3D shapes tool.
2. Inthe 3D shapes panel, select the a oG e
cat gi der th v
given under the category 3D - | s
models. Cmay |
3. Select the stickers tool. o '
Figure 3.13: 3D Model
4. Add eyes and tongue sticker to the cat.
5. Zoom in on the cat’s tail to add the fur texture.
6. Size and rotate the texture as desired.

& creATING 3D TEXT

The 3D text enables you to move it around the canvas and rotate in
different directions.

Follow the given steps to create some 3D Text.

Steps:
1. Select the text tool.
2. Click on the 3D text option.
'T' H T
. 4 =
computer ciass o
B i u
a CEETEY D TN
Figure 3.14: 3D Text Tool Figure 3.15: Creating 3D Text

x
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3. Choose the desired font, font size, colour, style and alignment to add
3D Text in the placeholder.

4. Click outside the placeholder to finish.

é HISTORY TOOL

ST SRR R
Each tool you use while -~ - - * .
making a new paint 3D g
model is recorded by the =
history tool. All of your T Computer -
actions can be reversed and -

undone, it’s like having an

endless undo button.
Figure 3.16: History Tool

By moving the History slider, you can replay the steps you used in creating
a drawing.

f:@'ﬁ Kids’ 1Q

Samaira was keenly watching her teacher while she was drawing a 3D cartoon.
Now, she forgets the steps which her teacher followed. Suggest a way she can recall
the steps.

! Let’s Recall

Windows 10 provides a free built-in creative app called Paint 3D.

« With the sticker tool, we can select images from a ready-made image collection
and apply them as stickers to our designs.

3D library is a collection of thousands of free 3D models.
« A freehand sketch can be transformed quickly into a 3D object using Paint 3D.
« 3D view enables you to edit from any angle.

 History slider replays the steps you used in creating a drawing.
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A. Fill in the blanks.

| enables you to edit from any angle.

2. allows replaying the steps used in creating a drawing.
3. We can choose 3D Doodle from .................... option.

4. enables you to move the text around the canvas.

5. e, is the area where we can draw different drawings.

B. Answer the following in one word.

1. The option allows drawing lines and stars.

2. Itis a collection of thousands of free 3D models.

3. 'The tool allows adding tongue sticker.

4. The number of options in paint 3D.

e N T s N N G

5. The tool which can reverse the action.

Write ‘T’ for True statements and ‘F’ for False statements.
1. We can rotate the 3D doodle after drawing it.

2. Each tool you use when making a new paint 3D model is recorded
by the 3D text tool.

3. Windows 10 provides a free built-in creative app called Paint 3D.
4. We cannot apply texture to a 3D model.

5. Zoome-in is not allowed in Paint 3D.

L
[
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D. Tick (v) the correct answers.

| tool is like an unlimited undo button.

( Ja3DText [ )b.Brushes [ )c History [ ) d.Canvas
2. allows to find the characters from the 3D library.

() a. Find () b.Search [ ) c.Explore [ | d.Locate
3. Weselect 3D shapes from the .....................

[ Ja Ribbon [ ) b.3Dlibrary [ ] c. Text () d. Effects
4, tool allows to add 2D or 3D text options.

() a. Stickers [ ) b.Brushes [ ) c.Canvas [ | d.Text
5. e, view allows you to move around your 3D designs.

() a.2D () b.3D () c. Sticker ([ )d. Animation

E. Answer the following questions.

1.  What is the purpose of 3D tools?




@ Rl L ‘

A. From the given grid, find out the components of Paint 3D.
R
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B. Neha wants to create a park scene. For it, she needs to add some 3D
objects on the canvas. Help her with the options through which she can
add different objects and create a beautiful park scene.

Team Work

Draw a poster on
‘Save Earth’ using
3D Library. Use the
stickers, 3D models
and 3D text to
beautify it.




MORE ON MS WORD 2016

Q Learning Outcomes

At the end of this chapter, students will be able to:
+ Move and copy the text.

+ Insert bullets, numberings and symbols.

+ Check the spellings and grammar.

+ Print the document.

Following sentences have some spelling and grammatical errors. Rewrite
the sentences correctly.

3. alia are swinging.

LB (T R Apprise the students that all the mistakes would have been underlined in MS Word 2016
LN [ICHR  if they had typed the above sentences with errors.

B X =X <

X eeflmes X X S . Computerd X M




“Hello friends! We have already
learnt how to edit the text in MS
Word 2016. In this chapter, we will
learn more about its editing features.

As we know, one of the most widely used word processors produced by
Microsoft is Microsoft Word. It facilitates the quick and simple creation,
reading, editing, and sharing of files. It allows making changes in the
content and appearance of the text. Text can be edited by inserting and
deleting text, correcting grammatical errors and changing font settings.

Let us learn about more editing features of MS Word 2016.

& voviNG TEXT

After you have done typing a section of text in Microsoft Word, you may
need to move it somewhere else.

Follow the given steps to move the text.

Steps: _
1. Select the text you want to move. s
2. Click the Cut command on the ST
Home tab. Alternatively, you can
press Ctrl+X on your keyboard. Figure 4.1: Cutting Text

3. Place your cursor point where you
want the text to appear.

|
)
.
[ ]
i

4. Click the Paste command on the e e
Home tab. Alternatively, you can
press Ctrl+V on your keyboard.

= Computer-4 [ 7o & X ﬁ XX T T¥T=EX XX®E=




& corving TEXT

Word enables you to copy text which is already in your document and

paste it to another location. € Let Me Answer
Follow the given steps to copy the text. | What is the easiest way to copy a text?

Steps:

1. Select the text you want to copy.

2. Click the Copy command on the Home tab.

Alternatively, you can press Ctrl+C on your  Figure 4.3: Copying Text
b SRS T S——
keyboard. ;

3. Place your cursor point where you want the
text to appear.

4. Select the Paste command on the Home tab. Figure 4.4: Pasting Text

& BULLETS AND NUMBERING

The use of bullets and numbering, often known as ordered or unordered
lists, can make writing easier to read.

Bulleted List

Bulleted list is used when order does not matter. These lists show a

graphic symbol with the list.
TS
Follow the steps to use the bulleted list. _ > —

Steps: - on e

1. Select the text you want to change into a list.

- Page Setup & the Pag
f'l:i_‘h'llill'i.-lhllp--\.-.-'q-nfﬂh"m Il:

Figure 4.5: Bullet List

2. Go to the Home tab, in the Paragraph group,
and click the bullets command.

e i — i'\-u i

3. A drop-down menu with different bullet
styles will appear, select the bullet style.

=

Sl=== 1=+ |&H-F

:';r.:ugr:mh

4. The selected text will have a bulleted list. Figure 4.6: Paragraph
ERY X === ==x X SSax X X === _ Compuerd =X 3B
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Numbered List

Numbered Lists follow some order and is used to display complete
sentences or paragraphs in a series.

Follow the given steps to create a numbered list. | wumseimsiscs

Steps: s |[2 :

1. Select the text you want to change into a -
numbered list. ! "

2. Go to the Home tab, in the Paragraph group,
and click the bullets command.

3. A drop-down menu with different numbering
styles will appear, select the numbering style.

Lr=fine ko Munnkeer Farma b

4. The selected text will have a numbered list. Figure 4.7: Numbered List

Inserting Symbols

You can easily insert a special character, fraction, or other symbols
such as currency, check marks, and many more symbols in your Word
documents. These symbols are needed in the documents where some
formulas are to be typed.

Follow the given steps to insert the symbols. TIO
Steps: e .
Take the cursor in the file at the spot where you want . f J J
to insert the symbol. ey 4
Go to Insert, and click on the symbol button located ~ ¢ ™ & & =
in the symbol group. e
Choose the desired symbol or click on more symbols. Inselzi[gigllllgeS;lf.ri:bols
Use the Font selector above the symbol list to pick the font you desire.
Once you get the symbol of your choice, double-click it.
The symbol will be inserted and select the close button.
Computer-4 | e X X SeSUEEE X X == = X == X X NN




é FIND AND REPLACE

Sometimes while typing, there are words which we type incorrectly. To
correct the spellings, we can use the Find and Replace option. The ‘find’
feature allows finding the word or particular text in the document and
the ‘replace’ feature allows to replace it with the corrected or another

Word' L Find -
Follow the given steps to find the text. % Replace

¢y Select ~
StepS: Ecditing
1. Click on the Home tab. Figure 4.9: Find

2. Select the Find button in the editing group.

3. A navigation panel will emerge on the left-hand side. Alternatively,
you can press Ctrl + F key combination to open the navigation panel.

4. Mention the word you want to search in the ‘Search Document’ box.

5. The mentioned word will be highlighted in the entire document.

Follow the given steps to replace the text.

Steps:

1. Click on the Home tab.

2. Select the Replace button in the .....
editing group. 1

3. Find and Replace box will appear.
Alternatively, you can press Ctrl

navigation panel.

In the * Find What box, type the word that needs to be changed.
In the ‘ Replace With’ box, type the new word to replace the old word.
Press the “ Replace All’ button.

The mentioned word will be replaced with the new word.

-----
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& spELLING AND GRAMMAR

MS Word has an in-built tool which allows to correct spellings and
grammatical errors.

Follow the given steps to check the spellings and grammar.

Steps: @ Let Me Answer

1. Select the text. Do you make errors while writing?

2. Click on the review tab.  E— T
3. In the proofing group, select — — e '
Spelling and Grammar.

4. The Sp elling panel Will Salwcl the pages i peragrmiin At oirialon pou weitl b Seage, Geck PAGE

. . '..l“":ll..lT * Pz Sl daie m'lllltl.ﬂ'- G F-!Elt.E-ll.:ll.' LT T I
appear On the rlght Slde. cibcw Potral o Lnrahscmge Click tre Appey b0 bos, el chil Jetacnes vl
Suggestions will be shown

. . Figure 4.11: Spelling and Grammar
to edit the incorrect word.

5. Either select change or change all option. Q T Do You Know?

@

Once done, a message will appear "The [y, open the spelling panel by
spelling and grammar check is complete. | pressing F7 key.

& vrint PREVIEW

A feature called print preview shows on the screen what a printed copy
would look like. By checking the layout using a “print preview’ before
printing, you can detect any possible problems and prevent the need for
multiple prints, resulting in saving ink or toner and paper.

Follow the given steps to preview a document.

Steps:

i

1. Click on the File tab. S
BER 17! e

2. Select the Print option. By pressing Ctrl + P key, the
3. A preview of the document will appear. | print preview will be shown.
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Printing the Document

Once the preview looks fine, follow the given steps to take the printout.

A printer must be connected with your computer to get the document
printed.

Follow the steps to get the print of a document.

Steps:

1. Click on the File Tab. . : =
2. Select the Print option. F

3. Choose the printer from
the Printer properties drop-
down list.

4. Mention the number of
copies required for printing. Figure 4.12: Print Preview

Press the print button.

6. Hard copy of the document will be there.

‘.j{@‘\? Kids’ ,Q

Shreya has typed a letter. Now, she wants a hard copy of it. What should she do?

@ Let’s Recall

Microsoft Word is one of the most widely used word processors produced by
Microsoft.

« We can use the cut, copy and paste option for moving and copying the text.
« Editing can only be done by selecting the desired text.
o Numbered List follows some order while the bulleted list doesn't.

 Print preview shows on the screen what a printed copy would look like.
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A. Fill in the blanks.

[

Bulleted list is used when .................... does not matter.

Editing can only be done by .................. the desired text.

The spelling panel appears on the ................... side.

Replace button is present in the ................... group.

The ..o, feature allows finding the word in the document

B. Answer the following in one word.

1.

2.

3.

4.

5.

The tab where the Cut option is present.

Spelling Panel will appear using this key.

The tab where the print option is present.

The list used for series.

This group has spelling and grammar option.

— ) T T

C. Write ‘T’ for True statements and ‘F’ for False statements.

1.

2.

Computer-4 | mm X X |

The numbered list does not follow the proper order.

Spell and grammar checks make the document error-free.
Editing means making changes in the already typed text.
Division symbols can be added using bullets.

Press Ctrl + P key combination to open the spelling panel.
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D. Match the following.

1. Ctrl+C Paste

2. Ctrl+P Find and Replace
3. Ctrl+V Copy

4. Ctrl+H Navigation Panel
5. Ctrl+F Print preview

E. Answer the following questions.

1.  Write the steps to move a text.




@ Critical Thinking
A. Gaurav typed an essay on ‘Summer Vacations. By mistake, he typed the
ending paragraph as the first paragraph. Suggest some options to him so
as to correct the essay.
B. Unjumble the Tabs.
L. SITNRE -
2. MHE O -
3. WVIERE - e
Team Work
Make a list of your subjects according to the alphabetical order. Run spell
check. Write more words that you want to spell check.
English Maths Science Hindi
computer Social studies Life skills. (books)
s a
. J
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FORMATTING FEATURES OF

MS WORD 2016
Learning Outcomes

At the end of this chapter, students will be able to:
+ Use formatting features.

+ Add pictures, shapes and symbols in a word document.

Some words are given in the box below. Segregate them into the appropriate

columns.
Get up early morning Addiction to social media  Play outside
Eat junk food Be punctual Exercise daily
Use offensive language Focusing on the negatives  Be happy

Good Habits Bad Habits

‘¥ Tjacher’s Apprise the students that in the above exercise, we have changed the appearance of the
2\ Note: NI Formatting.
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&

ﬁi\"’) “Hello friends! When we make our school \
b

: projects, we always beautify them by adding
stones, glitters and many more things. Lets
learn about different ways to make our typed
document look attractive.

Appealing documents always draw a reader’s attention. Microsoft Word
has a number of tools that can be used to modify the document and
give it a more attractive appearance by using various shapes, images, text

styles, etc.
y @ Lat Me Answer
How do you make your projects attractive?

& rABLES IN MS WORD

A document that includes several types of information, such as content,
numbers, images and many more information, requires the information
to be displayed in rows and columns. For example, the School Report
card and timetable. All the pieces of information are placed in rows and
columns.
—_—_————————==
Repurt EardTemplates Create Time Table in MS-Word

o TIME TABLE
E=S=8IS ' . &
—I I _

i " x — | | gt Wit - m T [ ol
- _ I e (g Y
e — e e
Figure 5.1: Report Card Figure 5.2: Time Table
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We find it simpler to read and better able to comprehend information
when presented in rows and columns. MS word allows us to represent
the information in the row-column format in a Table.

Adding Tables

A table is made up of rows and columns. The intersection of a row and
column is called a cell. )

k2 Let Me Answer
Can you name some other things
which are referred to as a cell?

Follow the given steps to insert a table in a
document.

Steps:
1. Click on the Insert tab and select the table button.

Cuvmy I'.Ia = Pu.w Tabse Piclutes Srapes Simalfal el
Page = Fage ek 2 2 -
12905 Tabics 1 ki oz

Figure 5.3: Insert Tab

2. A grid will appear, move the cursor over the -
grid until you highlight the number of columns
and rows you want.

ml

Figure 5.4: Insert Table
3. Click once and the table will be inserted in the document.

Once the table is inserted, simply click in the cell and start typing the
numbers, text, etc.

é WORDART

WordArt is a text modifying feature in Microsoft Word with effects
such as shadows, outlines, colours, gradients and 3D effects that can be
added to a word or phrase. It can be changed even after it is inserted in
a document.

B X X
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Follow the given steps to add WordArt in a document.

Steps:

1. Click Insert —— _
WordArt and ER A= L
pick the WordArt A o A A
style you want. A A A

2. Click on the bl
desired s tyle Figure 5.5: Inserting WordArt Figure 5.6: WordArt

3. The placeholder text box in the document with the sample text will

4

appear “Your text here”.

Enter your own text to replace the placeholder text. Nf ']t!

Editing and Formatting WordArt Text

Follow the given steps to edit WordArt Text.

Steps:
1. Select the WordArt you want to edit.
2. From the WordArt style drop-down list, select a WordArt style.
3. Select the Text effects from the different effects available in the Text
Effects drop-down list.
4. Click outside the dotted box.
5. The edited WordArt will appear.
R s L —
- A A _."
A A A omputer class iss o
A A A
Figure 5.7: Format WordArt Figure 5.8: Text Effect
X Compuerd | rmmm m X )R X X == X ¥ == X X NN




& (NSERTING PICTURE

Adding pictures in the written
document makes it look creative

Design Loyvowt Mleleiences Maibnge Hew

and intereSting' Let uS learn hOW I'E BRink  Pagi bt F!ﬁh Shapis ".'I‘|||'Ll'u'. l'lllull'. _-'_.IFEI:.II:_“:
. . . Pag Page [resk
to insert pictures in the word — .7
Figure 5.9: Insert Tab
document.

Follow the given steps to insert images in a document.

Steps:

1. Click on the Insert et .
tab. -'..-' '. : Rt

2. Under the Gty | T v e e e
illustrations group, |

select the pictures =
option. -

3. The Insert picture box = E
will appeatr. Figure 5.10: Insert Pictures

Explore the library and choose the image you want.
5. Select the picture and click on the Insert button.

The chosen picture will be inserted in the document.

& usiNG sHAPES

Shapes of all kinds, including boxes, rectangles, callouts, circles, arrows,
lines, triangles, curves, equation shapes and many more are available in
MS Word. Once the shape has been added, you can change its attributes,
such as colour, style, format, size and outline. Further, you can add 3D

effects such as bevelling, perspective, reflection or glow.

B X X
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Follow the given steps to insert Shapes in a Word document.

Steps:
A e Lasuui Eetspences Mabings |
1. Click on the Insert tab. Tl LBl Ll
. . Blank Magz Tabihe Ptuncs Bhapes SmamAn Chart Sorscmcha
2. From the illustrations group, select the > *=* -
Shapes option.

Figure 5.11: Shapes Button
3. Choose the shape from a long

list of shapes available.

4. Once the shape is selected, a (+)
shaped cursor will appear on
the page.

----------

5. Drag the mouse to draw out the
shape.

6. Release the mouse to get the
chosen shape.

Figure 5.12: Shapes ~ Figure 5.13: Inserting Shapes
Follow the given steps to format the shape.

Steps: s
REMEMBER IT! b —

1. Select the already inserted shape. The default colour of the

shape is blue.

2. Under drawing tools, select the format tab.

3. Select the desired options to modify the shapes.

Figure 5.14: Format Tab

& ForRMAT PAINTER

The format painter is a tool that enables us to apply a formatting effect

J
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from the previous text to other words or sentences. It facilitates our job
and saves a great deal of time, just like the copy and paste function.

Follow the given steps to apply formatting effect to any text.
Steps:
1. Select the text of which you want to copy the format.

2. Click on the Home tab.

3. From the clipboard group, select the format painter option.

4. Cursor will change to a brush symbol.

5. Position the cursor at the start of the text on which you want to apply
the format.

6. Drag the brush over the text.

7. The selected text will be formatted.

- Kids’ 1Q

You are the head girl/head boy of the school. You need to collect information about
the students of all classes. (Name, Parents’ name, age, address, phone number, etc).
You are really confused about what needs to be done in order to arrange the data

3 in suitable order. How would you manage? )

! Let’s Recall

A table is made up of rows and columns.

 The intersection of a row and column is called a cell.
» WordArt is a text modifying feature in Microsoft Word.
« We can insert different types of shapes in the document.

« Format Painter copies the format of some text to the other text.

B X X
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A. Fill in the blanks.

2.

3.

.................... and .................. are the two types of styles.

The text you enter into a new document by default is based on the
.................... style.

Lines, Basic shapes, Block Arrows are the options of ................... button.
The ..o, feature allows to create special text effects.

.................... is a placeholder where text can be typed in.

B. Answer the following in one word.

x

L.

2
3
4.
5

The default extension for MS-Word file.

The type of software is MS-Word.

The shortcut key to create a new document in MS-Word.

The use of combination keys Ctrl + S in Microsoft-Word.

— N N N N

The shortcut key to undo the last actions in the MS-Word.

— ) U U

Write ‘T’ for True statements and ‘F’ for False statements.

1.

2.

Text cannot be formatted within the text box.

You cannot insert text in Shapes.

The Ctrl+F1 key combination is used to hide/show the Ribbon.
Shape Fill tool is used for colouring a drawing object.

A theme is a set of formatting choices that can be applied to an

entire document.

0 0ougy
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D. Match the following.

1. Column Vertical Data

2. Row To combine two or more cells
3. Merging Horizontal data

4. Splitting To change the size

5. Resize Breaking of Multiple cells

E. Answer the following questions.

1.  What exactly do you mean by “style”? List the various styles.




@ Rl L

Write the words on MSWord and paste them infront of correct picture.

Orange

Green

Yellow

Purple

Brown

Black

Pink

Grey

Blue

&ig ’6* ‘
Baseball E
Basketball ‘
Fish %
Penguin dé\

5

Kitty ﬁ
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Team Work

Award Certificate Lesson Activity for Teaching Microsoft Word Skills

Microsoft Word Skills
“Award Certificate Activity”

". ™ L] z 5
R e .
.l Certificate of -
Appreciation

L]

™ B giaraed T ™
Robert VWV, Harrow
1" Wil | gl W ] o Y
et T Drad Pl LOTTME L i Bl Dol P v ey
Thiwrd T vkirmEs m e ppme, The cvline m ol mar
" ¢' CHws g DTS BTl R SO RN ST T T ﬂ

Description

This is a fun assignment where students design their own award certificate
for themselves or anyone else they desire by adhering to specific instructions.
Students will demonstrate their command of the following Microsoft Word
abilities after completion.

o Font And Paragraph Formatting

e  Page Orientation

o  Applying Pictures as a Page Colour
« Inserting Pictures And Text Boxes
o  Picture Background Removal

e Inserting Signature Lines

o Text Wrap

K X

I

I
M

X W X X S . Computr4 X




MORE ABOUT SCRATCH 3.0

Q Learning Outcomes

At the end of this chapter, students will be able to:
+ Know about different blocks in Scratch.
+ Change different backdrops in Scratch projects.

Label the Scratch Window components.

AT — lgm | Cores | s
. ! = - T L

= -

0 PPN PR Assist the students in labelling the components of the Scratch Window. Motivate them to
2\ W 1R  recall Scratch, which is a programming language that lets you create interactive stories,
animations, games, music and art.
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{t—’ b “Hello friends! In the previous \

class, we learnt about creating,
opening and saving Scratch. Now,
lets learn about the different blocks
in Scratch.

Scratch doesn't require any code for giving instructions to @
the computer. It uses blocks to perform a specific task. For &
using these blocks, all you have to do is to understand what o
these blocks can do for us.

& Brocks PALETTE

A vertical strip located just beneath the Code tab is described @

as a block palette. The Block palette contains a total of nine |
blocks. There are numerous sub-blocks available when we -
click on a specific block. Figlu:ré 6.1

Blocks Palette

& vorion BLock

One of the ten categories of scratch blocks is motion blocks. They are
@ Let Me Answer

Can you relate more with the characters
which shows movement? What do you

medium-blue in colour and are used to

direct a sprite’s movement on stage.

Follow the given steps to move a sprite | understand by motion block?
using Motion Block.

Steps:
1. Click on the Motion Block button.

(s X X S | Computerd X
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2. The code palette will show a list of blocks that belong

. ° GE.‘H
to Motion Block. . BEEm
3. Click on the move 10 steps block, and drag this block - =
to place it in the Script area. —
p P *.
4. Now, click on the turn 15 degrees block and place it , ==
just after the move 10 steps block in the script area. .# —
5. Run the code by clicking on the blocks in the script =F=
igure 6.2:
area. Motion Block
e
o B ﬁ
: B
. OO
* ===
. OGO
=) :
= L2
o =
=%
]
(= 0o
Figure 6.3: Using Motion Block
é LOOKS BLOCK ﬁ@let Me Answer
Purple-coloured blocks are Looks block. Ifyou ever work on a software that
. can change appearance, which
They control a Spr 1tes appearance mentor costumes you would like to
including its costume and backdrop. create? Imagine and discuss.

A

< Use the Say hello for 2 seconds block to display the message with
Sprite on the screen.

« Use Think hmm for 2 seconds to add a ‘thinking cloud’ to the Sprite.
It will continue to appear until another speech or thinking block is
activated, or the stop button is pressed.
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Follow the given steps to change the costume of a Sprite. [ IR
Steps: 2 e e
1. Click on Choose a Sprite button on the bottom right * EIE
side of the Scratch window. « B3
L]
[ty o |
2. Select Dani Sprite to click on the Costume tab. * =
_ -
3. From the list of costumes, select Dani-b costume. N ;;;e ”
4. The sprite’s costume will be changed. Look Block
& renBrock .
The Pen blocks are green in colour. These blocks draw : e
a trail as the Sprite moves on the stage. Pen colour can g
be changed. This block is present as an extension to the s
Scratch 3.0 . =
-]
Follow the given steps to add pens to the block category. © e
ollow the given steps to add pens to the block category - P
Steps: e
, , ]
1. Click on the Add Extension button at the bottom Figure 6.5:
left corner of the Code tab. Pen Block
2. Click on the E= .
Pen option : E:n
and it will be » we
added to the « L @
] m
Code tab. . < ==
[ = i
=== =
— 8 L=
o)
=0
= b= 00
Figure 6.6: Drawing Shapes with Pen Block
ERY X == = ==x X Sl X X === _ Computerd =X




& sounp Brock

Sound Blocks are in pink colour. The

" ("
. : : , = -
make animation lively by adding | REMEMBER 1T Ng

different sounds to a project. You can Blocks should be placed in order.

)

even record your voice and save it.

Follow the given steps to add sound in a project.

Steps:
1. Click the sound block.
2. Selectthe play sound meow until done and drag

this block and place it under the Script Palette.

3. Run the code by clicking on the blocks in the
Script area.

4. To stop all sounds being played on all sprites,
use the stop all sounds block.

& events BLoCK

Events Block is yellow in colour and controls the
events and the starting of the scripts. You can click
on the Sprite with a mouse or a keyboard to control
it. The interaction with the Sprite is called Events.

» Use when green flag clicked block to execute

the attached blocks when the green flag is
clicked.

» When the space key pressed block executes

the attached blocks when a keyboard key is
pressed.

i

e 8

« 919

Figure 6.7: Sound Block
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Figure 6.8: Event Block
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> When _

this sprite : m
clicked block  * Z= _ ?
executes the & Co o
attached * =
blocks when =« ==i
the left ﬁ -0
mouse is == o
chcked at the ujﬂi oo
Sprlte' Figure 6.9: Event Blocks Output
@ o
& conrroL BLOCK -
Control Block is amber in colour and controls the *
flow of the scripts. They provide functions for looping
various blocks and scripts. The most commonly used
control blocks are: o Duil
1. The repeat block: This block repeats a set of blocks #
for a given number of times. o pom
2. The wait 1 second: This block pauses the running
of the script till the specified time. -
&
3. The forever block: This block keeps on repeating a
set of blocks till the stop button is clicked.
é CHANGING THE BACKDROP Figure 6.10: Control Block

The stage background is the term used to describe the backdrop. To
make our projects more exciting and engaging, we can modify the stage’s
backdrop. By default, the backdrop of the stage is white. We can either
make our backdrop or choose the backdrop available in the library.

Below the stage area, the backdrop option is present.
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There are four different options for changing the INEEG_—_—_—————
backdrop of the stage. They are:

< Choose a backdrop

< Paint . E;‘i:
< Surprise

« Upload Backdrop

Follow the given steps to choose a backdrop for

the sprite. ;

Steps:

1. Click on the Choose a Backdrop button. Figﬂ ©
2. Choose a Backdrop window appears. Changing the Backdrop

3. From the preview list, select the Blue Sky backdrop. The Blue Sky
backdrop at the background of the Sprite will be added.

= Kids’ 1Q

Your friend is creating a project in Scratch. She wants to create a new Sprite in her
project. Suggest to her the steps to do the same.

! Let’s Recall

A vertical strip located just beneath the Code tab is described as a block palette.
o Numerous sub-blocks are available when we click on a specific block.
« Purple-coloured blocks are Looks block.
 Sound Blocks can record your voice and save it.
« Motion Blocks are used to direct a sprite’s movement on stage.

o Backdrop is referred to as the background of the stage.
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1.

2
3
4.
5

)Ey Upskill Your Intelligence '\“g

. Fill in the blanks.

Scratch uses .................... to perform a specific task.

Block Palette is a vertical strip located just beneath the .................... tab.
Below the .................... area, the backdrop option is present.
Purple-coloured blocks are .................... blocks.

By default, the backdrop of the stage is .....................

. Write the functions of these blocks.
1.
2.
3.

Turn 15degrees - L,
Think hmm for 2 seconds - ..........cocooovviiiiiiciinnn

Repeat10- L

. Write ‘T’ for True statements and ‘F’ for False statements.

Scratch requires code for giving instructions to the computer.
Control Block controls the flow of the scripts.
The interaction with the Sprite is called Events.

Pen colour cannot be changed.

oo

Motion Block is used to direct a sprite’s movement on stage.

. Tick (v') the correct option.

1.

Which of the following blocks are used to control the appearance of
Sprite?

() a.Control [ ) b.Sound () c. Looks () d. Event
The term is referred to as the background of the stage.

() a. Canvas () b. Backdrop
() c. Workarea () d. Foreground

B X X
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3. Colour of Looks blockis ......ccc............

() a. Yellow [ )b.Pink () c. Green () d. Purple
4. The block controls the events and the starting of the scripts.

() a Looks [ )b.Motion [ ) c.Event () d.Pen
5. Pink colourisof ................ block.

( Ja. Sound [ )b.Motion [ Jc. Pen () d. Control
Answer the following questions.

1.  Write the use of Motion blocks.




@ Critical Thinking

A. John is creating a story with audio in Scratch. He notices that the audio is
playing even after the story is over. Suggest him the way which he should
use to stop the audio.

v4 R | W | C I | W | E C
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Team Work

Work in pairs. Create this project in Scratch and enjoy it.

;_ L I
: m g
Iﬂ [
""_ &
. D
_H:—
. SO .
R =
ot
= =
- &
)
nﬂ:l O 6
ERY X === ==x X SEesx =X X === . Compuerd =X




MS POWERPOINT 2016

Learning Outcomes

At the end of this chapter, students will be able to:
+ Start PowerPoint 2016.
+ Differentiate between slides and presentation.

+ Know the components of the PowerPoint Window.
+ Create, save and close the presentation.

Rahul and Saumya are best friends. Rahul adopted a cat a few days back, and
Saumya is curious about her. So, she asks several questions, and Rahul shows
the pictures for her answer.

Match the questions asked by Saumya with the pictures shown by Rahul.

Column A Column B
Q1. What is the colour of your cat? ‘{,_
Q2. What do you feed your cat? ® fl’
Q3. What do its eyes look like? | & "
Q4. Which is its favourite posture? o

Inform students that the human mind is capable of understanding visual clues better than
2\ N PYPYR  words and introduce them to that one such program which allows us to present information
effectively is, M'S PowerPoint 2016.
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PowerPoint is a popular application , £
REMEMBER IT! &

program that allows you to create
and show slides to support a
presentation. These presentations
can include animations, narrations,

ﬁi?" b “Hello friends! Its always better to
' beautify the text file with pictures and
animations. Lets learn how to do it.

To create a shortcut for Microsoft
PowerPoint 2016, drag its icon from
the start menu to the desktop.

images, videos, backdrops and more.

é ADVANTAGES OF PRESENTING DATA IN POWERPOINT

Using a PowerPoint presentation has the following advantages.

1.

Organise and structure your presentation.

2. Animate your slide to enhance the visual impact.
3.
4

Make ideas more attractive so that others can easily understand.

Provide an illustrative backdrop for the content of your presentation.

& sTARTING MS POWERPOINT 2016

Follow the given steps to start MS PowerPoint 2016.

Steps: <)
1.
2.
3.

Chck on the Start button_ Start Screen is also called Backstage View.
Scroll down to Alphabet P and click on PowerPoint 2016.

PowerPoint Screen appears.
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Figure 7.1: Starting PowerPoint Figure 7.2: PowerPoint Home Window

Presentation and Slides are two very important components of PowerPoint
2016. A slide in PowerPoint is where information can be placed in the
form of text, pictures, sounds, animation and much more. A collection
of many slides is called a Presentation. The introductory slide of the
presentation is called the Slide Master. When all the combined slides of
a presentation are shown to the audience, it is called a Slide Show.

é COMPONENTS OF MS POWERPOINT 2016 WINDOW

Quick Access Toolbar Ribbon Placeholder

Click to add title

Lo 1o add subsinile

Navigation Pane

Notes Pane Zoom Control

A1 TR el e W — i |

Figure 7.3: Components of PowerPoint Window
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Quick Acces Toolbar:

This toolbar appears on the left side of the PowerPoint 2016 title bar. It
contains shortcuts for commonly used commands, such as Undo, Redo,

Save, slideshow and many more. Let Me Answer
Discuss the difference between a real
The Ribbon: ribbon and a ribbon in MS PowerPoint.

The rectangular bar on the top of the PowerPoint window just below the
Title bar is The Ribbon. A ribbon is made up of Tabs and Groups. It has
multiple tabs, each with several groups of commands.

- v r—— ] B————

Figure 7.4: PowerPoint Ribbon

Slide Navigation Pane:

You can easily organise your slides using the Slide Navigation Pane on
the left side of the screen. From here, you can duplicate, rearrange, and
delete slides in your presentation.

Vertical & Horizontal Scroll Bars:

In a presentation, we can view a particular slide section by clicking,
holding, and dragging the vertical or horizontal scroll bar.

Slide Pane:

We can view and edit the chosen slide right here.

Zoom Control:

We can change the percentage view of a slide by adjusting the zoom. The
number to the right of the slider reflects the zoom percentage.

X mm(ffas= X X S | Computerd X
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Notes Pane:

Notes can be written here for the current slide. The speaker can only
view them and doesn’t appear when the presentation is running.

Slides View Option:

There are different slide viewing options.
Normal View:

It is the default view in which the selected slide is displayed, along with
the slide navigation window.

Slide Sorter:
It displays smaller versions of all the slides in the presentation.
Reading View:

In this view, we can review slides more easily because all the modifying

tools are hidden in this. oh
=+ Let Me Answer
Slide Show: Howrdo you like to view the slides?

Slides from a presentation will be played through this.

Backstage View:

Backstage View
create new X |Fn
presentations. You
can also open,
save, print, create
PDF and share
presentations from
the Backstage view.

e -oEaaREy &~ e--ili- W]
Figure 7.5: Backstage View
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é CREATING A NEW PRESENTATION
Follow the given steps to create a new presentation.

Steps:

;m °

&% m Do You Know?

1. Click on the File Tab. Ctrl + N is the shortcut key combination
for making a new blank presentation.

2. Select Blank presentation in the Backstage view.

3. A new blank presentation will appear with a blank side.

[ faren

Figure 7.6: New Slide Option

& suive Lavout

The arrangement of the slide’s contents is referred —

to as the slide layout. Depending on the kind of | - ILayout -
information we want to include, we can choose E -] Reset

a layout for our slide. Every time we make a new Slide ~ [ Section
slide, we must select a slide arrangement that
works with the information. A slide’s default
layout is “Title Slide Layout.”

Slides

Figure 7.7: Layout Button
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Follow the given steps to change the layout. i

Steps:
1. Click on the home tab.
2. Inthe slides group, click on the Layout button.

3. Select an appropriate layout for your slide.

é SAVING A PRESENTATION Figure 7.8: Slide Layout
Always save the presentation before closing it. It allows to reaccess the
presentation in the future.

Follow the given steps to save a presentation.

Steps:

Click on the File tab.

Select the save or save as command and click on the Browse option.
The Save as dialogue box appears. Select the location of a file.

Give the name to the presentation.

Click on the Save button.

The presentation will be saved with an extension .pptx.

1.
2.
3.
4.
5.
6.

Into

e il P S = | e T

Figure 7.9: Backstage Window Figure 7.10: Save As Dialog Box
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& CLOSING A PRESENTATION

Follow the given steps to e

=

close the presentation. = |

Steps:
1. Click on the File tab.
2. Select the close option.

3. 'The currently open

presentation will be
closed. Figure 7.11: Closing a Presentation

& ExITING A PRESENTATION

To exit PowerPoint, click on the Close button (x) on the Title bar.

& ..,,@\v KldS ’Q

What is the difference between closing a presentation and exiting the PowerPoint?

! Let’s Recall

PowerPoint is a popular application program that allows you to create and
show slides to support a presentation.

 PowerPoint provides an illustrative backdrop for the content of your presentation.
A collection of many slides is called a Presentation.

 You can easily organise your slides using the Slide Navigation pane.

o Slide Sorter displays smaller versions of all the slides in the presentation.

o Different layouts can be chosen based on the information.

« Microsoft Office saves the presentation with an extension .pptx.
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A. Fill in the blanks.

1. A collection of many .................... is called a presentation.

2. view is the default view in PowerPoint.

O is the shortcut key combination for making a new
presentation.

4. Microsoft office saves the presentation with an extension .....................

5. pane is used to write notes.

B. Answer in one word.

1. The arrangement of the slide’s contents. ( )

2. 'The percentage view of a slide can be changed by
adjusting the zoom. ( )

3. We can view and edit the chosen slide right here.

—/

4.  'This toolbar appears on the left side of the
PowerPoint 2016 title bar. (

—

5. From here, you can duplicate, rearrange and delete
slides in your presentation.

N
—/

C. Write ‘T’ for True statements and ‘F’ for False statements.

1. The introductory slide of the Presentation is called the
Introduction.

A ribbon is made up of Tabs and Groups.
A slide’s default layout is “Title Slide Layout.”

MS PowerPoint doesn’t allow to add animations.

AN T

Slide Pane contains shortcuts for commonly used commands,
such as Undo, Redo and many more.
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D. Tick (v') the correct option.

1.

Quick Access toolbar doesn’t contain a shortcut for this command.

() a.Redo () b. Save () c. Open () d. Undo
.................... displays smaller versions of all the slides in the presentation.
() a. Slide Sorter () b. Normal View

() c. Slide Show () d. Reading View

In which tab, Save As option is present?

() a. Format [ | b.Insert () c. File () d. View

The view which hides all the editing tools to make slides easier to review.
(] a. Reading View () b. Normal View

() c. Slide Show () d. Slide Sorter

The rectangular bar on the top of the PowerPoint window just below the
Title bar.

() a. Quick Acces Toolbar () b. The Ribbon
() c. Slide Show () d. Slide Navigation Pane

E. Answer the following questions.

1.

2.

What is the use of MS PowerPoint?




X Computerd [ =X = == x

3. Explain different Slide view options.

4. Write the difference between slides and presentation.

5.  What is the use of the ribbon?

@ Critical Thinking

A. Rearrange the letters to get the correct word.

a. NIOTTANSEEPR - e,
b. LEDISS -
c. DEARGIN- e,
d. TOUYAL - s
e. NBRIOB-

B. Harman has made a beautiful presentation on “Save Earth”, but she has
forgotten the steps to save it. Suggest the option she can use to complete
the task.

Team Work

Find out information on ‘Global Warming’ and prepare 10 slides in
PowerPoint. Include causes and ways to prevent it.
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MORE ON POWERPOINT 2016

Q Learning Outcomes

At the end of this chapter, students will be able to:
+ Insert a new slide and delete a slide.

+ Format text in a slide.

+ Insert pictures from a file or internet.

+ Apply colour to the background of a slide.

Rohan and Sohan have learnt about MS PowerPoint 2016, but Sohan doesn’t
remember the components of MS-PowerPoint Window. Help Sohan to recall.

Click to add title

i o il el i i

KA TN Acist students with labelling the components of MS PowerPoint 2016. Also, ask them to
recall why PowerPoint is a useful presentation tool.
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ﬁ'—.’ k “Hi friends! In the previous

' chapter, we learnt about the uses
of MS PowerPoint. Now lets learn
using the slides in PowerPoint. |

You are already familiar with how to make slides and add text. You will
discover more about PowerPoint’s advanced features in this chapter.

& 0PENING A PRESENTATION
Follow the given steps to open the saved presentation.

Steps:
1. Click on the File tab. s e
2. Select the open |

command from the left
pane.

3. Locate and select the
presentation you want to
open.

4. Click on the Open button.

Figure 8.1: Opening a Presentation

& INSERTING A NEW SLIDE
Any number of slides can be inserted in our presentation.

Follow the given steps to insert a new slide.

N
o

—
Steps: &% Do You Know?

. We can create a duplicate slide by
1. Click on the Home tab. pressing Ctrl + D key combination.
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2. From the slides group, click on the New slide. S22 Let Me Answer

How do you realise that

el s s something is irrelevant and
4. A new side is inserted. needs to be deleted?

3. Select the type of slide you want.

Alternatively, you can click on the Insert tab > New slide.

Deugr Franafnons Armumanong Sl Show vy W Hecording
= B ] L 3
e | B =1 &
& m+ = 4 B} [ Getadoems
ey Talale Pretures Soreenshot  Phato Shaped SemanArt Char B by Add-ins
Slice - Alaym
HHidkei Tabday =~ i HE Bl rabinni aghd-wia Links

Figure 8.2: Inserting New Slide

a DELETING A SLIDE

Some slides may look irrelevant, so we can delete them in the Normal
view or in the Slide Sorter view.

Follow the given steps to delete a Slide.

Steps:
1. Choose the slide you
want to remove.

2. Right-click on it in the
Outline Pane.

3. From the shortcut
menu, choose the
Delete Slide option.

4. 'The slide will be deleted. Figure 8.3: Deleting a Slide

a FORMATTING TEXT IN A SLIDE

Making changes in the text’s appearance to make it more exciting and
attention-grabbing is referred to as formatting.

B X ==X <
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We can use the following features to format slides in a PowerPoint
presentation.

& FONT STYLE AND FONT SIZE

Follow the given steps to change the size of the selected text.

BRI U e s &S

Figure 8.4: Font Size

group, click on the drop-down A Let Me Answer
arrow next to the Font Size box. | What is the perfect font size according to you?

Steps:

1. Select the text you want to
change. 7

2. On the Home tab, in the Font

3.

Click on the desired font size, and the text size will be changed.

Follow the given steps to change the style of the selected text.

Steps:

1.
2.

A

Select the text you want to change.

On the Home tab, in the Font group,
click on the drop-down arrow next to
the Font Style box.

Move the cursor over the available font
styles.

Select the desired font style.

The font style will be applied to the
selected text.

& cHANGING FONT COLOUR

Follow the given steps to change the font colour.

x

Figure 8.5: Font Style
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Steps:

1.
2.

3.
4

Select the text. SR
On the Home Tab, click on the iuu“

drop-down arrow next to the Font |

colour box. ED:_ Priter
Choose the desired colour. Figure 8.6: Font Color

The font colour will be applied to the selected text.

& ApDING PICTURES

Pictures have more visual impact than the text. PowerPoint lets you
insert images or pictures in your presentation.

Follow the given steps to insert an image from a file.

Steps:

1.

5.
6.

Take the cursor where you I'—
want to insert a picture on

the slide.

Click on the Insert tab; click
on the Pictures button in
the Images group.

|

A dialogue box will appear. -
. Figure 8.7: Inserting Picture
Browse to the location where

you have saved your picture file.
Select the desired picture and click the insert button.

The picture will appear on the slide.

Follow the given steps to insert an image from the internet.

Steps:

1.

Take the cursor where you want to insert a picture from the internet.
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2. Click on the Insert tab.
Click on the drop-down
arrow in the images group :
below the picture button. ’ 5

3. Clickonthe Online Pictures "
button.

4. A dialogue box will appear. —
Type the name of the picture
you want to search in ‘ Search Item name’ and then press enter.

B

e

o

Figure 8.8: Inserting Online Picture

5. Related pictures will appear.

Select the desired picture and click on the Insert button.

Resizing Pictures

The size of the images can be increased or decreased.
Follow the given steps to resize the image.

Steps:

Click on the image.

Sizing handles will appear around the edges of the picture.
Move the mouse pointer over a sizing handle.

The shape of the cursor will change to a double-headed arrow.

o »N

While holding the mouse button, drag the mouse inwards to decrease
or outwards to increase the size of the picture.

6. Release the mouse button once the picture is resized as desired.

Moving Pictures

The position of the pictures can be changed.

Follow the given steps to change the position of the picture.
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Steps: es
1. Click on the image. i

2. Sizing handles will appear around % £
the edges of the picture. W
3. Move the mouse pointer over a

sizing handle. -

Figure 8.9: Moving a Picture
4. 'The shape of the cursor will change to a four-headed arrow.

5. While holding the mouse button, drag the mouse in the required
direction.

6. Release the mouse once the picture is positioned.

é ADDING COLOUR TO THE BACKGROUND OF A SLIDE

There are many ways of setting background colour in a slide. Let’s learn
about the following ways.

Using the Themes Option

Follow the given steps to add a background style using the theme options.
e ey Tl L]

Steps: — T T TSTE W -
1. Click the desired slide. — DRI RIS
: : & #a,#*ﬁ *£H
2. Click on the Design tab. In the 4 ﬁﬁ % & +"‘¢ X
Themes group, choose the themes R *’ w—

you want to apply.

Figure 8.10: Applying Th
Using the Solid Fill Option igure 8.10: Applying Themes

Follow the given steps to add a background style using the Solid Fill
options.

Steps:

1. Select the Format Background button from the design tab.

X m())ems X X sk . Computerd X
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2. In the format Background Pane, Eri——
Choose solid or gradient fill.

Select Apply to all on the format L _

background pane if you want all slides Figure 8.11: Applying Themes

to have the same background colour.

3. Choose the desired colour option.

4. 'The colour of the slide changes.

Using the Picture or Texture fill Option

Follow the given steps to add a background style using the Solid Fill
options.

Steps:
1. Select the Format Background

button from the design tab. f

2. In format Background Pane, — ——
Choose Picture or Texture fill. —

3. Choose a picture in the Insert _
picture. Figure 8.12: Applying Background

4. Browse and select the picture you want to apply on the slide and
press the Insert button.

5. The chosen picture will be applied as a background to the slide.

& suive sHow

Slide show is a series of slides which displays all the slides on the screen
one by one. The slide show should be previewed so that any necessary

T i

modifications may be made before it is finalised. -__J

REVMEMBER IT! 88
Follow the given steps to view the Slide show. Use the F5 key to view

the slide show.
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Steps:
1. Click on the Slide Show tab.
2. Select one of the following options in the Start Slide Show group.

a. From Beginning

=

Starting the presentation with

the first slide. File Home Insert Design
b. From Current Slide | 0 |'l; | E'_:f

Starting the presentation with  From From Custom Slide

the current Slide. Beginning Current Slide Show ~

) Start Slide Show

c. Custom Slideshow Figure 8.13: Viewing Slide Show

Starting the presentation with only the selected slides.

“You can add only 50 slides in one presentation’ said Mayank. Do you think
Mayank is right?

! Let’s Recall |

PowerPoint 2016 helps you create beautiful presentations.

o Slide show is a series of slides which displays all the slides on the screen one
by one.

« A presentation is made up of a series of slides.

o The size of the images can be increased or decreased.

o Pictures have more visual impact than text.
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A. Fill in the blanks.

5.

.................... is a series of slides which displays all the slides on the screen
one by one.

We can delete the slides in the ................ view or in the ................
view.

A is made up of a series of slides.

Select Apply to all on the .................... if you want all slides to have the

same background colour.

Release the .................... once the picture is positioned.

B. Match the following.

1.
2.
3.
4.

5.

Slide Show Ctrl + O
New Slide F5

Save as Ctrl + M
Quit F12
Open Ctrl + Q

C. Write ‘T’ for True statements and ‘F’ for False statements.

1.
2.

Computer-4 :_ b © € ¢ % —

We cannot resize an image in MS PowerPoint.

The ‘from the beginning’ starts the slide show from the current
slide.

We can select the Format Background button from the design
tab.

Themes and pictures can be applied to a presentation.

JUuu U o

Home tab is used to insert a picture from a file.
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D. Tick (v') the correct option.

1.  Which tab is used to add a font colour in the text?
() a Design () b. View () c. Home () d. Insert

2. Which tab contains all the options to change the background of a slide?
() a. Format () b. Design
() c. Slide Show () d. Animations

3. While resizing the picture, The shape of the cursor will change to a
() a. Single-headed arrow () b. Flower
() c. Double-headed arrow () d. Pointer

4.  Making changes in the text’s appearance is referred to as
() a. Formatting () b. Viewing
() c. Resizing () d. Moving

5. Which of the following shows the smaller version of the slide?
() a. Normal View () b. Slide View
() c. Outline View () d. Slide Sorter View

E. Answer the following questions.

1.  Write the steps to insert a new slide in a presentation.

2. What do you mean by slide show?

3. How can we move a picture in the presentation?
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4. What do you mean by formatting?

5. How would you insert online pictures in a presentation?

A. Raman’s teacher has given him the steps for opening a presentation, but
they are not in order. Number them in the proper order to help Raman.

(] Select the open command from the left pane.
(] Click on the Open button.

D Locate and select the presentation you want to open.

D Click on the File tab.

B. Niharika has made slides on ‘Water Pollution’. She forgets to add the
background to the slides. Suggest the way how to add slides with the

background.

Team Work

In the previous chapter, you created 10 slides on ‘Global Warming’ . Now
add more slides using background and formatting learnt in this chapter.
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Let’s play this game with your friends.

;/:’eli)a;els How do you
Reckoner? organise your
: files?
Can vou How many
) Y Move ahead versions
What live without 3 spaces are there of
is data? computers?
msoffice?
Do you ; Move 1 WWhat y01‘1
K - can draw in
now a step ahead . >
lot about paint 3d?
computers? g T

What is
the best
thing about
Go back ! _ computers?
to start

Name
different
types of

computers.

What is

the best
thing about
Who is the computers?
Define father of
program. computer?

What i Name two
Move back atis your functions of

3 spaces favourite toolbars in
software? n
paint 3d?

Do you think
your data is Is mobile a
safe on your computer?
Computer?

al

Computer-4
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Roll a dice with your friends and wait for your turn to play the game.




